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Use this
space for notes

Introduction
Access 3 is a course created for CAL PACT participants to learn more about the
features of Microsoft Access. The course covers introductory material to provide
you with the fundamental knowledge to create a database using Access. It also
serves as a future reference for you as you continue to gain experience on your
own. Some topics may not be covered in as much detail during the course session
as they are in this document. Documentation is available for previous versions of
Access for Windows on the CAL PACT website: http://calpact.berkeley.edu.

Skills you need for this course
•  How to use the mouse
•  Familiarity with the Windows operating system
•  Familiarity with other applications in the Microsoft Office suite

Skills and concepts you will learn in this course
•  Creating and modifying Forms
•  Creating and modifying Reports
•  Importing and Exporting data
•  Creating Reports

Conventions used in this document
Menus and menu commands are separated by a vertical bar ( | ). In the document
they will appear as Menu|Command. An example of this is: “Select File|New...”
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So far in the Access classes we have been dealing with Tables and Queries.
These two objects are basic elements that define your database.  However, these
two objects may not be the best ways to view and enter data.
For example, when working in Datasheet view of a table object, you are staring at
all the records that are in that table and you may only want to focus on one.  If this
table had many fields, these fields probably extend beyond the width of your screen.
This forces you to scroll to the right to see the particular field that you want.  In this
situation, it would be more practical to view one record at a time, and view all the
data completely without having to scroll.
These same issues apply when you want to print your data or when you want to
make a presentation to others.  You want your data to be in the clearest possible
format and Tables and Queries sometimes don’t do the job.
To solve these problems we can use Forms and Reports. Forms allow you to
adjust how you display your Tables and Queries into a variety of different formats.
This is primarily used for viewing data and entering data on a computer.  Reports
are used, similar to templates, so that when you print out your data it is formatted in
the way you want.  You can use this feature to generate reports of your data, to
make mailing labels, and many other printable items.

Forms
Forms can be created based on either existing tables
or queries. In general, it is more common that forms are
based on tables.  Information entered in forms can be
saved for later use. Whatever information is entered in
the form will be saved into the table that the form refers
to.  This is an important distinction! Forms never “save”
data. It’s just a “nice” way to look at (or change) data in
your tables - the building blocks of your database!
Autoform provides a fast and easy way to create a
form. This function can be accessed by first selecting
the desired table from the Table tab (in the Database
window) and then selecting the Autoform function from
the New Object button pull down menu on the toolbar.

Likewise, you can get the same
effect by selecting the Forms
tab (in the Database window)
and clicking on New. Select
AutoForm: Columnar and
select the desired table from the
pull down menu. Either method
tells Access to create a form
based upon the field names you
designated when creating the
table.
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Once the form is created, current records can be viewed by clicking on the arrows
at the bottom of the form.   Just as with tables, records can be deleted by selecting
Edit|Delete Record when the record you want to delete is currently displayed.

Design View 

Forms in Design View allow you to manipulate the way data will appear.  Field
headers and cells as well as text and background colors can be changed with this
option.

Form Layout & Size
You may notice that there are doubles of each field. The transparent boxes are
labels, which always appear with the text inside the box. The corresponding white
boxes will contain the actual data for each specific record when in Form view.
The size and layout of field names and entry blanks can be rearranged to suit your
needs. The overall form size can be changed by moving the mouse cursor over the
borders of the form until you see a double headed arrow, as shown below. Then
click on the mouse and drag the form to its new size.

Field names and entry blanks can be moved by clicking on the appropriate box and
then putting the mouse cursor over the border that appears. The mouse cursor will
change to a small black hand (below). Click and drag the box to its new location.
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These objects can be rearranged in data pairs or individually. By default, moving a
label object will also move its corresponding data object, and vice versa. Select the
object as if you were going to resize it and put the mouse cursor over one of the
border outlines.  Then, click and drag the objects to their new location.
At times you’ll want to move an indivudal object.  Select the object (by clicking once)
and move the mouse cursor to the top left corner of the object until a hand with a
pointing finger appears, then click and drag. This type of move will only affect the
individual object selected and not its corresponding “pair.”

The size of the objects can also be changed. First select the box, then move the
cursor over one of the eight small black boxes (“resizing handles”) around the
selected object. A double headed arrow will appear. Then click and drag the box to
its new size.

Text/Display Formatting
Labels (field names) can be changed by selecting the object and renaming it once
the cursor appears in the field.  However, use caution changing the input box
objects!  These names refer to field names, and if changed, you’ll lose the
“connection” to the particular field!
The text and the background of both the field and input boxes can be changed by
using the Background, Foreground, and Border buttons on the toolbar. Select the
object you wish to change, then click on the desired box  and
select your color options from the pull down menu. To apply the same color
formatting to another box, use the Format Painter button on the toolbar, designated
by the paintbrush. Select the object whose format you wish to copy, then click on
the Format Painter button ( ).  A new cursor will appear which looks like a
pointer and paintbrush. Then click on a box to apply the new format.  To apply the
format to multiple objects, double-click when selecting the Format Painter button.

New text can be added into the form by selecting the Label button ( ) from the
Toolbox menu ( ). If you wish to change the label for a specific field, click within
the object and change the text.  Manipulation within the Detail section will retain
form modifiers, such as text/background color and labels, although the information
displayed within the boxes changes for each record.
Color changes can be made to any object in the design grid. Text, objects, and
backgrounds can be assigned colors other than those designated by the Form
Wizard. Select the background or cell you want to change and then select the color
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from the Fill/Back Color palette to make the change. Select the object and then
select a color from the Font/Fore palette to change text colors.

More Advanced Forms
Forms can be used to view entries individually or allow a more customized manner
of data entry. The easiest way to begin a form is to use the built-in Autoform, the
method we have been using so far.  But you can also design and create forms from
scratch.  Like many Microsoft
products, there are many ways
to accomplish the same thing.
One way to create a new Form
is through the Form Wizard.
This wizard helps automate the
process by taking care of some
of the finer details.  Select New
from the forms tab (in the
Database window) and select
the Form Wizard along with the
table you wish to include in the
form.
You will then be prompted to select the fields you wish to add to the form.  Notice
that you can choose fields from different tables and queries.  This allows you to use
fields from related tables in the same form.
Next, select a layout you want your form to follow from the given set.  On the next
screen choose an aesthetic scheme that will decide the font, colors, and
backgrounds that will be used in your document.  In the last screen you will be
asked to provide a name for the new Form, and to choose whether you want to go
to Design View to further customize your form, or to Form View to start entering
data.  That’s it, you’re done!

Manually Designing a Form
Aside from using the Form Wizard,
you can also create forms manually.
This can give you more control
when creating a form. But it is also
more time consuming than using the
Form Wizard. Begin by clicking
Create from in Design view under
the Forms tab.

Next, click the Properties ( )
button and select the Data tab. Select
a table or query to be the source of
the fields for your form.  A new
window should appear with a list of
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available fields. Click and drag the fields from the list to the Detail area of the form.
When  you drag and drop the Fields on to the Form workspace, two boxes will
appear.  The left (usually transparent) item is the Label and the right box is the
Detail area that will contain the data from the underlying Table.
Every object on in your form has its own set of properties.  To access these
properties click on the object, and then select the Properties ( ) button. Or, you
can right click the object and then select Properties... Every object has its own set
of items that can be specifically adjusted to format that object.  If you wish to format
the “Forms” properties, (i.e. the entire documents properties), click anywhere in the
back ground and select the Properties button on the toolbar.  Because there are a
multitude of properties that can be adjusted for each object, we will not cover them
here.  Once the Properties window is opened, it will remain open while you edit your
form unless you close it.  If you click on another object, the Properties window will
then show the properties of the newly selected object.

Enhancing a Form
Combo Boxes
Combo boxes allow you to quickly call upon a list of records from a particular field
to be added into a form. Instead of having to type in the field value manually, combo
boxes enable you to select the proper value from a drop-down menu that can refer
to separate tables. Combo boxes can be added to a form in Design View using the
Combo Box button on the Toolbar. Select an area where you would like the box to
be located and click on the spot.
You will then be guided through the Combo Box Wizard to help you set up this
option. The first window allows you to designate where the data for the box will
come from. To avoid confusion, it is usually best to refer to an existing table/query
for the combo box to draw its values. Select the option “I want the combo box to
look up the values in a table or query,” and the next two windows ask for the table
and fields it will reference. The following window allows you to adjust the column
width of the box. The two subsequent windows give you the option of what field to
choose as the value to be stored in your form/database and the field to which it will
be saved.  If you choose to store it in the form, it will be a value local to the form that
is not located in any underlying table.  If you choose to store the value in a Table, it
will store the value in the field that you specify.   Finally, choose a name for the
combo box and let the Wizard do the rest.

Text Boxes
Text boxes allow you to input information that you may find useful to include in a
form, but not necessarily as a part of a table. (Ex. Displaying the annual income of
an employee based upon weekly hours and hourly pay fields). Similar to combo
boxes, text boxes can be added to a form in Design View by clicking on the Text
Box icon ( ) from the Toolbox window and clicking on a space within your form.

You will notice that a label and data objects appear. They need to be given a
function since they do not refer to any table’s field. Double-click the label object and
rename it, then click on the data object and select the Properties button from the
toolbar.
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For example, to calculate an employee’s weekly pay, I would want to divide my
table’s “salary” by 52.  I could do this by selecting Data under the object’s property
window and select the Expression Builder button from the Control source. Then
I could build an expression as with like we did in Access 2 while working with
queries.

Creating Reports
Reports are a useful way to present your information when a hard copy of your data
is needed. New reports can be created by selecting the Report option for the New
Object pull down button or by selecting New from inside the Reports tab (in the
Database window). Then select Report Wizard and choose the table or query from
which the report’s data will come.

Choose the desired fields from the available tables/queries to add to your report.
Finally, the Report Wizard will take you through various steps on how you would like
your report to be displayed, including text layouts and formatting designs.

Formatting reports is very similar  to formatting Forms.  After creating a Report, go
to Design View.  The layout and  the tools bars are almost identical.  Once you get
used to making Forms, you can easily produce reports.

Reports and Mailing Labels
Once a report has been created, Access allows you to easily customize it with
features like time stamps and graphics. Since the main purpose of a report is to
produce a hard copy of your information, these options serve as nice additions.
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Mailing Labels
You can create labels by first beginning a new report.  You must click on the New
icon in the Reports section of the Database window.  Then select Label Wizard
and specify the proper table or query that your labels will be based on.  You will then
be prompted to select a label size and layout options.  If you know the label brand
and item number, you can specify it, or, you can create your own dimensions.
When creating a prototype label, feel free to use spaces, commas, and returns.
Your labels will have an identical layout to your prototype. Next, select how you
would like your labels sorted and finish by choosing a name for your mailing label
report.

Time Stamps
A time stamp can be easily
integrated into your report by
adding a text box (see previous
section) and altering its properties
in Design View. Once you have
added the text box, select it and
view its properties by clicking the
Properties button ( ).  Click on
the Format tab and select the date
layout from the Format cell’s pull-
down menu. Then, switch to the
Data tab and use the Expression
Builder from the Control
Source’s cell.  At the bottom of the
folders column, select the Common Expressions folder, choose the appropriate
expression, and close the window.

Integrating Graphics
Access also allows you to integrate a wide range of pictures in many graphic
formats. In Design View, select Unbound Object Frame from the Toolbox
window and click on the area you wish to place the image. The Insert Object
window appears, which allows you to select your graphic. Click on “Create from
File” and browse the graphics files on your computer until you locate an appropriate
image and click Open.

Exporting & Importing Data
Access can import and export data from many types of non-Access database files,
such as Microsoft Excel and Foxpro, Dbase, Paradox, Lotus 1-2-3, and delimited/
or fixed-width text files.

Importing Data
External data must be imported into an existing Access database file to be usable
by Access. Begin by opening a database file you would like the imported data to be
added to or create a new database file. Select File|Get External Data|Import.
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Select the data source by first selecting the data type from the pull down menu
under Files of type. Then browse the available storage devices and folders until
you locate the appropriate file. Select the file for import and click the Import button.
Select the component(s) you wish to import and then click on the Options button.
The option checkboxes enable you to import into Access formatting, relationships,
special toolbars, and so forth that were created in the original application.

Exporting Data
Access database files may also be saved to work with other applications by
exporting an existing database. Highlight the table you wish to export and select
File|Export.... In the Export To window, select the location to store your exported
file and select the type of file to export as by using the down pointing arrow under
Save as type. If you wish to retain any formatting applied to the data (fonts, lookup
fields, field widths, etc.), click the Save Formatted checkbox. Finally, click Save to
save the file.
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